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Certification Prep Series consists of individual guides that provide practice in the 
basic skills needed to be successful using the corresponding software. No previous 
software experience is required. Although the guides focus on learning skills, not 
test taking, users that complete the practice will be prepared to take the official 
software certification exam and exhibit workplace readiness. Step-by-step instructions 
demonstrate actual software commands and features, building from basic to advanced. 
Content is divided into small units for better learning and usage. There is no need to 
purchase additional materials as all lesson content is created using the software.

 Provides an affordable way to prepare for industry certification versus other methods.
 Integrates easily into existing classroom activities.
 Focuses on hands-on experience to develop skills.
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Introduction
The Common Occupational Readiness Essentials (CORE) series of certification 
preparation guides focuses on mastering the essential basic skills needed as 
a workplace-ready user of the software. The goal of each CORE certification 
preparation guide is to provide practice in each essential basic skill required by 
employers who use the software. To prove workplace readiness, you will also be 
prepared to take the official certification exam for the software.

CORE Adobe Flash CS5 will help prepare you to take the Adobe Certified Associate 
(ACA) Adobe Flash CS5 certification exam. It provides step-by-step instruction 
for the features and commands covered on the certification exam. The focus 
of the lessons is to practice using the actual commands and features instead of 
creating a complete end product. Most lesson content is created using the software, 
and minimal downloading of files is required. Furthermore, each certification 
preparation guide is broken down into small learning units to enable better 
comprehension and application of the software. Where required, answers are 
provided at the back of the certification preparation guide.

Certification as an Adobe Certified Associate demonstrates an aptitude with Adobe 
software. ACA certification is offered for Adobe Dreamweaver, Adobe Flash, 
Adobe Photoshop, Adobe Premier, Adobe Illustrator, and Adobe InDesign. 
Certification exams are provided by Certiport, Inc., through various testing facilities. 
Visit www.certiport.com for more information on registering for certification exams.

About the Author
D. Michael Ploor is the author of the CORE series of certification preparation guides. 
Mr. Ploor’s students have achieved exceptional results with the CORE certification 
preparation guides. His students collectively pass more than 500 industry certification 
exams each year without the need for other preparation materials. Mr. Ploor has 
demonstrated the strength of integrating the CORE guides in a diverse mix of courses.

Mr. Ploor is also the author of three textbooks on the subject of video game 
design: Introduction to Video Game Design, Video Game Design Foundations, and 
Video Game Design Composition. He is a National Board Certified Teacher in Career 
and Technical Education and holds an MBA degree from the University of South 
Florida. He maintains professional teaching credentials in Business Education and 
Education Media Specialist.

Mr. Ploor is at the forefront of innovative teaching and curriculum. He developed 
STEM curriculum while serving as the lead teacher in the Career Academy of 
Computer Game Design at Middleton Magnet STEM High School. Mr. Ploor 
has applied his skills as a STEM Curriculum Integration Specialist in designing 
innovative curriculum and by collaborating to construct the state standards for 
video game design in several states. He has also been instrumental in authoring 
competitive events for Career and Technical Student Organizations such as the 
Future Business Leaders of America (FBLA) and Phi Beta Lambda (PBL).

In addition to publishing textbooks and lessons, Mr. Ploor provides professional 
development as a frequent presenter at regional and national conferences to 
promote CTE education and video game design curriculum for the high school and 
middle school levels.
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Lesson 4 
Images and Text

Objectives
Students will set the stage dimensions. Students will import an asset into the library. 
Students will trace a raster image to create a vector image. Students will replace color 
on an object. Students will obtain data from the Info panel. Students will create an 
image mask. Students will describe how to add text to a Flash document. Students 
will adjust color effects on an object. Students will publish a Flash document in other 
formats. Students will set compatibility when publishing a document.

How to Begin
 1. Before beginning this lesson, download the needed files from the student 

companion website located at www.g-wlearning.com, and unzip them into your 
working folder.

 2. Launch Flash.

 3. Applying what you have learned, create a new ActionScript 3.0 document.

 4. Click Save As… in the File pull-down menu. A standard save dialog box is 
displayed. Save the file as LastName_Balloon in your working folder.

Setting Stage Dimensions
The stage has a default size, but the size often must be changed to match the 
requirements of the project. The stage dimensions are changed by adjusting the 
document size.

 5. Click Document… in the Modify pull-down menu. The Document Settings 
dialog box is displayed, as shown in Figure 4-1.

 6. Click in the left-hand Dimensions: text box, and enter 600 px. This is the number 
of pixels in width for the document and stage. The px means pixels.

 7. Click in the right-hand Dimensions: text box, and enter 600 px. This is the 
number of pixels in height for the document and stage.

 8. Click the OK button to the change the size of the document and stage.

Importing to the Library
Assets are the elements within an animation, such as objects, sounds, background, 
and characters. Assets can be added to the Library panel using the Import 
command. This creates a library for the project, which is a central storage location 
so assets can be quickly located and added to the animation.

 9. Click Import and then Import to Library… in the File pull-down menu. A 
standard open dialog box is displayed. It may take a few seconds for Flash to 
prepare to import before the dialog box appears.
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 10. Navigate to your working folder, select the Hot 
Air Balloon image file, and click the Open button. 
The asset is added to the library.

 11. Click the Library panel to display its contents, as 
shown in Figure 4-2.

 12. Click the Hot Air Balloon.jpg file name in the 
lower part of the panel to preview the image.

 13. With the Hot Air Balloon image selected in the 
library, click the panel menu button in the top-
right corner of the panel, and click Properties… 
in the drop-down menu. The Bitmap Properties 
dialog box is displayed, as shown in Figure 4-3. 
Notice the information at the bottom of 
the dialog box. The current compression 
method has reduced the file size to 10% of the 
uncompressed size.

 14. Click the Compression: drop-down arrow, and 
click Lossless (PNG/GIF) in the drop-down list. 
This will change the compression method to 
lossless compression.

 15. Click the Test button. Notice this compression 
method only reduces the file size to 26% of the 
uncompressed size.

 16. Check the Allow smoothing check box, and click the OK button to update the 
asset.

 17. Drag the Hot Air Balloon image file from the Library panel, and drop it onto the 
stage. The asset is inserted into the current frame.

 18. Click the zoom setting drop-down arrow at the upper-right of the document 
window, and click Show All in the drop-down menu. The magnification of the 
document is changed so everything fits within the document window.

 19. With the asset selected, display the Properties panel.

 20. Click the X: coordinate in the panel to make it editable, and enter 75.

 21. Click the Y: coordinate in the panel, and enter 0.

Enter the width Enter the height

Figure 4-1. 

The stage size is set by changing the document dimensions.

Click to display
the panel

Panel
menu button

Click to select the asset
and preview the image

Preview

Figure 4-2. 

Imported assets are displayed in the Library panel.
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 22. Click the link icon to the left of the W: dimension. This locks the aspect ratio so 
as the width is changed, the height is proportionally changed or vice versa.

 23. Click the H: dimension in the panel, and enter 600. This sets the height of the 
image to match the height of the stage. The image now fits entirely within the 
stage and is centered.

 24. Double-click on the layer name (Layer 1) in the Timeline panel. The name is 
made editable. Change the name to Balloon. Press the [Enter] key to set the name.

Tracing a Raster Image
Vector images, not raster images, are the best to use in a Flash animation. However, 
the balloon image is a raster image. It needs to be converted to a vector image. Some 
image quality will be lost in the conversion.

 25. Click the New Layer button in the Timeline panel.

 26. Applying what you have learned, rename the new layer as Vector.

 27. Verify that the Vector layer is above the Balloon 
layer in the Timeline panel. If not, drag and 
drop it at the top of the list. The order of the 
list from top to bottom determines the order 
of layers. The objects on a layer will obscure or 
hide all layers beneath.

 28. Turn off the visibility of the Balloon layer by 
clicking the dot in the column below the eye 
icon, as shown in Figure 4-4. The layer is not 
deleted, just hidden from view.

 29. Applying what you have learned, add the Hot 
Air Balloon image to the stage. The asset will be 
placed on the current layer, which should be the 
Vector layer.

 30. Make sure the image is selected. If not, click the Selection Tool button, and click 
the image to select it.

New Layer

Selection Tool

Click to test
the setting

Select a compression
method

Click to allow smoothing

Figure 4-3. 

Changing the properties of a raster image in the library.

Click to hide
the layer

Click to show
the layer

Figure 4-4. 

The visibility of a layer is turned on or off in the 
Timeline panel.
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 31. Applying what you have learned, change the 
properties of the image to the same settings 
previously used. The image should be the same 
size and in the same location as the previous 
image.

 32. Click Bitmap and then Trace Bitmap… in 
the Modify pull-down menu. The Trace 
Bitmap dialog box is displayed, as shown in 
Figure 4-5.

 33. Click in the Color threshold: text box, and enter 
125.

 34. Click in the Minimum area: text box, and enter 10. Lowering the minimum area 
will create a vector image with more clarity, but will substantially increase the 
file size. Setting the minimum area larger will create fewer vector shapes. This 
will make the image less detailed.

Set the color
threshold

Set the minimum
area size

Figure 4-5. 

Creating a vector image by tracing a raster image.

TIP
The maximum 
value for the 
Minimum area: 
setting is 1000.  35. Click the OK button to convert the image to a vector image.

 36. Click outside the image to deselect it and see the results. Notice the color 
differences that occur when a raster photograph is converted to a vector image.

 37. Click the Subselection Tool button, and click the edge of the balloon. Notice 
the individual shapes created when the vector image was created. Some of the 
larger shapes are visible with a solid fill.

 38. Click Undo action in the Edit pull-down menu or press the [Ctrl][Z] key combination. 
Do this as many times as needed to undo the tracing of the raster image.

 39. Applying what you have learned, trace the raster image again with a color 
threshold of 50 and a minimum area of 1000 pixels.

 40. Click the Subselection Tool button, and click the edge of the balloon. Notice 
how far less detail is preserved.

 41. Click the Selection Tool button, click outside the image to deselect it, and click 
any part of the dark blue sky. The upper part of the sky is now a single shape. 
Notice how only the dark blue is highlighted when it is selected.

Subselection Tool

TIP
You can click and 
drag a selection 
box around an area 
containing vector 
objects to select all 
of those objects.

 42. Click and drag the dark blue sky away from the balloon. Notice how the tracing 
operation converted the colors of the sky into a vector object.

 43. Press the [Delete] key to remove the dark blue sky.

 44. Applying what you have learned, delete the remaining sky and anything else 
not part of the balloon.

Replacing Color 
The fill color of a vector object can be easily changed. For the balloon, the fill colors 
will be adjusted to minimize the shadow on the right-hand side of the balloon.

 45. If needed, turn off the visibility of the Balloon layer so only the Vector layer is 
visible.

 46. Click the Selection Tool button, and click a dark red object on the right-hand 
side of the balloon. The dark red objects are in the shadow.

 47. Display the Properties panel.

 48. Click the Fill Color color swatch, and click the color mixer button in the color palette 
that is displayed, as shown in Figure 4-6. The Color dialog box is displayed.
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 49. Click in the Red: text box, and enter 165.

 50. Click in the Green: text box, and enter 25.

 51. Click in the Blue: text box, and enter 5.

 52. Click the OK button to replace the fill color of the selected object. Notice how the 
object is now a lighter red, as if that area of the balloon is receiving full sun.

 53. Notice that there are two shades of red in the shadow, a lighter and a darker 
red. With the Selection Tool active, hold down the [Shift] key, and click each of 
the darker red areas on the right-hand side of the balloon. The [Shift] key allows 
multiple objects to be selected.

 54. Applying what you have learned, change the color of these darker red objects to 
R140, G25, B5.

 55. Applying what you have learned, change the color of the objects in the shadow 
as shown in Figure 4-7. When finished, the right-hand side of the balloon should 
be much lighter and not in shadow.

Obtaining Data from the Info Panel
Knowing the exact RGBA color settings for a single pixel can be helpful when 
deciding on a color to select or match. This information is reported in the Info 
panel. This information also can be used to identify any areas of the balloon with a 
specific color that have not been changed.

 56. Click Info in the Window pull-down menu or click the collapsed Info panel to 
expand the panel.

 57. Move the cursor over the stripe on the balloon, and examine the RGBA values 
shown in the Info panel, as shown in Figure 4-8. Notice the alpha value (A:) is 
100%, which means the color at the cursor’s location is 100% opaque (not see-
through). The alpha channel controls opacity.

Click to display
the color palette

Color mixer button

Color palette

Figure 4-6. 

Changing the fill color of a selected object.
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 58. Determine which blue in the stripe you like best, and note the RGBA value of 
that color.

 59. Applying what you have learned, change all objects in the stripe so the fill 
matches the blue you chose.

Color in 
Shadow

Replacement Color—Light Replacement Color—Dark

RGB Hex RGB Hex

Red R165, G25, B5 #A51905 R140, G25, B5 #8C1905

Orange R235, G35, B20 #EB2314 R200, G45, B10 #C82D0A

Yellow R200, G165, B50 #C8A532 R195, G130, B25 #C38219

Black R100, G85, B75 #64554B R70, G60, B50 #463C32

Goodheart-Willcox Publisher

Move the cursor
over the stripe

Click to display
the Info panel

Coordinate location
of the cursor

RGBA
values

Info
panel

Figure 4-8. 

The Info panel displays color and coordinate data about the cursor’s location.

Figure 4-7. 

The color settings for changing objects on the right-hand side of the balloon.
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 60. Click outside the image to deselect it, and then click any object in the stripe. 
Notice how Flash has automatically joined all of the objects into a single object 
when all of the colors were changed to match.

 61. Applying what you have learned, display the color palette in the Properties panel 
for the stripe object, and click the Alpha: % setting, as shown in Figure 4-9.

 62. Change the setting to 50, and press the [Enter] key. The stripe is now 50% 
opaque. In this case, since the background is white, it looks like the color is 
lightened, but if another object were behind the stripe, it would be partially 
visible through the stripe.

Masking an Image
An image mask can be used to exclude parts of an existing image. The mask will 
reveal only the parts of the image that are covered by the mask.
 63. Applying what you have learned, turn off the visibility of the Vector layer and 

turn on the visibility of the Balloon layer.
 64. Applying what you have learned, create a new layer, and name it Mask.
 65. Applying what you have learned, position the Mask layer below the Vector layer, 

but above the Balloon layer.
 66. Click the Oval Tool button in the Tools panel.
 67. Applying what you have learned, change the fill color to yellow with an alpha 

setting of 50%. By making the color semitransparent, you will be able to see 
through it to make the mask exactly where you want it.

 68. Click the Stroke Color color swatch in the Properties panel, and click the no 
stroke swatch, as shown in Figure 4-10. This means the object will be drawn 
using only the fill color.

 69. Click and drag on the stage to draw an oval that covers most of the balloon. You 
will adjust the object later, so its size does not need to be exact at this point.

Oval Tool

Change the
alpha setting

Figure 4-9. 

Changing the alpha channel setting in the Properties panel.

TIP
If the oval does not 
appear, the image 
may be set to be 
on top. Select the 
image, and click 
Arrange>Send to 
Back in the Modify 
pull-down menu.
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Adding Text
Text can be added to the stage to provide decoration or information. The Properties 
panel is used to modify the text.

 73. Display the Vector layer, hide all other layers, and make the Vector layer current.

 74. Click the Text Tool button in the Tools panel, and click anywhere above the 
balloon. A text box is placed on the stage and active.

 75. Enter the text Balloons are Fun. Notice the text is in the current fill color and 
alpha setting.

 76. Click the Selection Tool button in the Tools panel, and then click the text box so 
it is selected.

 77. Click the Text Engine drop-down arrow (first) in the Properties panel, and click 
Classic Text in the drop-down list.

 78. Click the Text Type drop-down arrow (second) in the Properties panel, and click 
Static Text in the drop-down list.

 79. Set the position to X=150 and Y=5.

 80. Set the width to 330.

 81. Click the Family: drop-down arrow in the Character area of the Properties 
panel, and click Broadway in the drop-down list. If this font is not available, 
choose any serif typeface.

Text Tool

TIP
To have a layer 
not affected by the 
mask, drag the layer 
to the bottom of the 
indented stack, and 
then drag to the left 
until the black line 
is all the way to the 
left, and drop the 
layer. To make a 
layer affected by the 
mask, drag it into 
the indented stack.

 70. Click the Subselection Tool button in the Tools panel, and click the edge of the 
oval. Handles are displayed on the oval, as shown in Figure 4-11.

 71. Drag the handles to distort the oval so it completely covers the balloon.

 72. Right-click on the Mask layer in the Timeline panel, and click Mask in the 
shortcut menu. All areas of the layers below the Mask layer that are not covered 
by the mask are blocked from view, as indicated by the layer names being 
indented under the Mask layer.

Subselection Tool

Click to remove
the stroke

Click to set the
stroke color

Figure 4-10. 

Removing the stroke color from an object.
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 82. Click the Size: setting, and enter 36. This sets the size of the type in points, as 
shown in Figure 4-12.

 83. Click the Color: swatch, and change the color to #0000FF (blue) with an alpha 
setting of 100%.

 84. Click the Anti-alias: drop-down arrow, and click Anti-alias for readability in the 
drop-down list. This applies a form of antialiasing that is best for reading, as 
opposed to animated text.

 85. Expand the Options area of the Properties panel, click in the Link: text box, and 
enter http://www.balloons.com as the URL. This makes the text a hyperlink.

 86. Click in the Target: text box, and enter _blank. An entry of _blank will open the 
link in a new browser tab or window.

Adjusting Color Effects
To this point, you have worked with basic color properties. Other color settings such 
as tint and brightness can be changed as well.

Drag Bézier handles
to change the curvature Bézier handle Handle

Figure 4-11. 

Adjusting the shape of an oval object to match the balloon shape by dragging the handles.
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 87. Applying what you have learned, create a new layer named Colors, and place it 
on top of the layer stack.

 88. Applying what you have learned, add an instance of the Balloon image file to the 
Colors layer, and make it the same size and in the same location as the previous 
instances. Note that since this layer is not below the Mask layer, the mask will 
not affect it.

 89. Make sure the lock icon for the Colors layer in the Timeline panel is not 
displayed so the layer is unlocked.

Text
properties

Text is
added

Figure 4-12. 

Adding text and changing its properties.

TIP
When a layer is 
current, a pencil 
icon appears next 
to its name in the 
Timeline panel. If 
the layer is locked, 
the pencil icon 
will have a slash 
through it.

 90. Hide all layers other than the Colors layer.

 91. Select the balloon image on the Colors layer.

 92. Click Convert to Symbol… in the Modify pull-down menu. The Convert to 
Symbol dialog box is displayed, as shown in Figure 4-13. 

 93. Click in the Name: text box, and enter movie_balloon.
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 94. Click the Type: drop-down arrow, and click 
Movie Clip in the drop-down list.

 95. Click the center box in the Registration: area to 
set the origin of the object.

 96. Click the OK button to convert the image to a 
movie clip.

 97. Expand the Color Effect section in the 
Properties panel.

 98. Click the Styles: drop-down list, and examine 
the different color effects available.

 99. Click Alpha in the drop-down list, click in the 
Alpha: text box that is displayed, and enter 50.

 100. Applying what you have learned, change the 
tint setting to 20% with a red value of 0, green 
value of 200, and blue value of 0.

 101. Turn on the visibility of the Balloon layer.

 102. Toggle the visibility of the Colors layer to see the changes from the original 
image on the Balloon layer and the adjusted image on the Colors layer. Notice 
the effect of the color effect adjustments. The image on the Colors layer looks 
like an aged photograph.

 103. Save your work.

Publishing in Other Formats
Flash files are generally saved in one of two formats: SWF and FLA. The file saved 
in the previous section is a Flash document in FLA format. This is the native file 
format for Flash. SWF, which is generally pronounced swif, is a vector-graphic 
animation format. Other software can create an FLV file, which is a Flash video 
format.

 104. Turn on the visibility of all layers, and arrange them in this order from top to 
bottom: Mask with Balloon indented below it, Vector, and Colors. The Vector and 
Colors layers should not be indented under the Mask layer so they will not be 
affected by the mask. This produces an image with the masked balloon image 
on top, the text visible, and the tinted sky visible, as shown in Figure 4-14.

 105. Toggle the visibility of each layer to see how the image is assembled.

 106. Click Publish in the File pull-down menu. Two files are saved in the same folder 
where the FLA file is stored: SWF and HTML. The HTML file is created so the 
SWF can be viewed in a web browser.

 107. Using the system file explorer, navigate to your working folder. Notice there are 
three LastName_Balloon files in the folder.

 108. Hover the cursor over each of the LastName_Balloon files to display the help text. 
If the system is set up to display file extensions, you will not need to display the 
help text for a file to determine its type.

 109. Double-click on the LastName_Balloon.html file to open it in the default web 
browser. If a message is displayed warning of ActiveX content, allow the 
content to be displayed.

Select the type
of symbol

Set the
origin

Name the symbol

Figure 4-13. 

Converting a raster image into a movie clip symbol.



42 CORE Adobe Flash CS5

Copyright Goodheart-Willcox Co., Inc.

Vector layer

Mask layer
with the Balloon

layer visible

Colors layer

Figure 4-14. 

The layers are all visible, and their order has been adjusted to show and hide various features.

 110. Click the hyperlink Balloons are Fun. A new browser tab or window is opened 
and the www.balloons.com website is displayed.TIP

By default, Flash 
blocks Internet 
links when the 
file is stored on a 
local drive instead 
of at an Internet 
address. If a 
warning appears 
when clicking the 
hyperlink, cancel 
the warning, right-
click on the image 
in the browser, and 
click the Global 
Settings… in the 
shortcut menu. 
Then, take the steps 
necessary to add 
your local machine 
as a trusted location.

 111. Close both tabs or browser windows.

 112. Double-click on the SWF file to open it in the Adobe Flash Player installed on 
your computer.

 113. Click the hyperlink Balloons are Fun. A browser window is opened outside of 
Adobe Flash Player, and the www.balloons.com website is displayed.

 114. Close Adobe Flash Player and the web browser. Leave the Flash open.

Publishing for Compatibility 
There are many different versions of Adobe Flash Player. If the SWF document is 
created for a newer version of Adobe Flash Player than the user has installed, he or 
she will have to download a new version to view the document. Saving as an earlier 
version of Flash, Flash Lite, or AIR format can add a level of compatibility for the 
SWF across devices.
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 115. Click Publish Settings… in the File pull-down menu. The Publish Settings 
dialog box is displayed, as shown in Figure 4-15.

 116. Click the Flash tab in the dialog box, and click the Player: drop-down arrow. 
Examine the list of options for compatibility. Click Flash Player 8 in the drop-
down list. This will allow devices with Adobe Flash Player 8 or later to view the 
document.

 117. Click the Script: drop-down arrow. Notice that ActionScript 3.0 is not an 
option with Flash Player 8. If this document contained any scripting written 
in ActionScript 3.0, it could not be saved to Flash Player 8 compatibility. Click 
ActionScript 2.0 in the drop-down list.

 118. Click in the JPEG Quality: text box, and enter 100. This will increase the 
resolution quality of the JPEG-compressed images.

 119. Click the Formats tab, and make sure the Flash (.swf) check box is checked.

 120. Check the Macintosh Projector check box. Notice the .app file extension is 
included in corresponding File: text box. The Macintosh Projector option creates 
a standalone Mac application that the user can run or download as an app if it 
is submitted to the iTunes store.

Select the version of
Adobe Flash player

Set the JPEG quality

Figure 4-15. 

Compatibility can be added by publishing a document for an older version of Adobe Flash Player and by creat-
ing a standalone application that can be played on a PC or a Mac.

TIP
More recent features 
of Flash may not be 
supported by older 
versions of Adobe 
Flash Player, which 
will make those 
features unavailable 
or the document 
unusable. Since the 
balloon animation 
is a very basic 
document, saving in 
an older format will 
not cause a problem.
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 121. Uncheck the Macintosh Projector check box, and check the Windows Projector 
check box. Notice the File: text box displays the .exe file extension on the file 
name. The Windows Projector option creates a standalone Windows application 
that the user can run.

 122. Click the Publish button.

 123. Using the system file explorer, navigate to your working folder. Compare the 
file size of the EXE and SWF files by displaying the help text for each. Notice 
how much larger the EXE file is.

 124. Run the EXE by double-clicking the file, and test the hyperlink.

 125. Save your work, and close Flash and all other windows.

Lesson Review

Vocabulary
In a word processing document or on a sheet of paper, list all of the key terms in 
this lesson. Place each term on a separate line. Then, write a definition for each 
term using your own words. You will continue to build this terminology dictionary 
throughout this certification guide.

Review Questions
Answer the following questions. These questions are aligned to questions in the 
certification exam. Answering these questions will help prepare you to take the exam.

 1. How is the stage size changed?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 2. Which tool or panel of the interface is used to change the X or Y coordinate of 
an object?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 3. Briefly describe how to trace a raster image to create a vector image.

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 4. How is the fill color of a selected object changed?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

TIP
The Enable JPEG 
deblocking check 
box will apply a 
deblocking filter to 
remove some of the 
blurry-block areas, 
called artifacts, 
caused by JPEG 
compression.
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 5. What does the alpha channel setting control?

 ___________________________________________________________________________________

 6. Which panel displays the RGBA values and the coordinates at the cursor’s 
location?

 ___________________________________________________________________________________

 7. What happens to the parts of an image that are outside of the mask shape when 
the mask is applied?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 8. How is a layer turned into a mask? 

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 9. In which area of the Properties panel is a hyperlink added to text?

 ___________________________________________________________________________________

 10. How is a hyperlink configured to open in a new browser tab or window?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 11. Briefly describe how to add a yellow tint to a movie clip symbol (object).

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 12. What are the three file types in which a Flash file is generally saved?

 ___________________________________________________________________________________

 13. What is the native format for Flash?

 ___________________________________________________________________________________

 14. What setting when publishing a Flash file is used to remove artifacts in JPEG 
images?

 ___________________________________________________________________________________

 15. How can a Flash document be published so it is compatible with Adobe Flash 
Player 6 and Mac computers?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________
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Answers

Lesson 1
 1. Shape, form, line, color, value, space, and texture.

 2. Regular shapes and objects that are used to 
assemble more complex shapes or objects.

 3. The primary colors of red, blue, and yellow.

 4. A complementary color is located opposite of 
the selected color on the color wheel, while an 
analogous color is located next to the selected 
color.

 5. Positive space is the area or volume occupied by 
the primary objects, while negative space is the 
area or volume around or between the primary 
objects.

 6. The point or points in a perspective drawing 
where receding parallel lines appear to meet.

 7. Movement, emphasis, harmony, variety, balance, 
contrast, proportion, pattern, and unity.

 8. Movement.

 9. Emphasis.

 10. Balance.

 11. An image is divided into three sections 
horizontally and three sections vertically to 
create nine areas, and where the lines cross are 
the focal points for a scene.

 12. Contrast.

 13. Unity.

 14. To achieve site-wide consistency.

 15. Shorter development time, easier maintenance, 
and improved usability.

Lesson 2
 1. RGB

 2. CMYK

 3. It is the total spectrum a given color model can 
produce.

 4. Bit depth of 8.

 5. The alpha channel allows for a masking 
color, which is a single shade of a color that 
determines areas of transparency in the image.

 6. Vector.

 7. The process of converting a vector image into a 
raster image.

 8. Raster images are composed of colored dots 
at specified locations, while vector images 

are composed of elements recorded by their 
mathematical definitions.

 9. Applying the most appropriate resolution and 
file compression.

 10. Download it from a digital camera.

 11. The image is dithered, and the software creates 
a color through interpolation.

 12. 576

 13. Bicubic for enlargement.

 14. A serif font has decorations called serifs at the 
ends of letters, while a sans serif font lacks these 
decorations.

 15. Sans serif.
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Lesson 3
Figure 3-2
 1. Selection Tool

 2. Subselection Tool

 3. Free Transform Tool

 4. 3D Rotation Tool

 5. Lasso Tool

 6. Eraser Tool

 7. Stroke Color

 8. Swap Colors

 9. Delete Anchor Point Tool

 10. Oval Tool

 11. PolyStar Tool

 12. Spray Brush Tool

 13. Pen Tool

 14. Text Tool

 15. Line Tool

 16. Rectangle Tool

 17. Pencil Tool

 18. Hand Tool

 19. Fill Color

 20. Add Anchor Point Tool

 21. Convert Anchor Point Tool

 22. Rectangle Primitive Tool

 23. Ink Bottle Tool

 24. 3D Translation Tool

 25. Brush Tool

 26. Deco Tool

 27. Bone Tool

 28. Paint Bucket Tool

 29. Eyedropper Tool

 30. Zoom Tool

 31. Black and White

 32. Gradient Transform Tool

 33. Bind Tool

 34. Oval Primitive Tool

Figure 3-3
 1. Snap to Objects

 2. Polygon Mode

 3. Magic Wand

 4. Object Drawing

 5. Magic Wand Settings

 6. Faucet

Review Questions
 1. The layout of the toolbars, panels, and document 

on the screen.

 2. A small window that holds commands or 
options.

 3. The Timeline panel.

 4. The stage is the area where the on-screen action 
is displayed, while anything on the pasteboard 
will not appear in the final output.

 5. The scene bar above the pasteboard.

 6. By clicking the document tab of the document to 
display.

 7. By clicking Reset ‘workspace name’ in the drop-
down menu displayed by clicking the workspace 
switcher button.

 8. Click the Subselection Tool button in the Tools 
panel.

 9. At the bottom of the Tools panel.

 10. A flyout is a toolbar that contains additional 
tools and is indicated by a black triangle at the 
bottom-right corner of a tool.
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Lesson 4
 1. By changing the document size in the Document 

Settings dialog box.

 2. The Properties panel.

 3. Select the image, click Modify>Bitmap>Trace 
Bitmap…, and set the color threshold and 
minimum area.

 4. Click the Fill Color color swatch in the Properties 
panel, and select a color in the palette that is 
displayed or click the color mixer button to 
define a color in the Color dialog box.

 5. The opacity of the object to which the color is 
applied.

 6. The Info panel.

 7. Anything outside of the masked area is hidden.

 8.  Right-click on the layer in the Timeline panel, 
and click Mask in the shortcut menu. Any layers 
in the stack below that layer will be masked.

 9. The Link: text box is located in the Options area 
of the Properties panel.

 10. Enter _blank in the Target: text box in the 
Options area of the Properties panel.

 11. In the Color Effect area of the Properties panel, 
click Tint in the Style: drop-down list, and adjust 
the Red:, Green:, Blue:, and Tint: sliders to the 
color and level desired.

 12. FLA, SWF, and FLV

 13. FLA is the native format for Flash.

 14. The Enable JPEG deblocking check box should 
be checked.

 15. In the Publish Settings dialog box, set the 
Target: drop-down list to Flash Player 6, and 
check the Mac Projector check box in the OTHER 
FORMATS area. 

Lesson 5
 1. To enhance the content of a website and create 

animated, rich content.

 2. Easing.

 3. The onion skin.

 4. Action is defined on keyframes, and Flash 
creates the tweens to fill in the action between 
the keyframes.

 5. Shape tweening, because the object is gradually 
changed from one basic shape on the first 
keyframe to another shape on the next keyframe.

 6. Motion tweening.

 7. Motion tweening.

 8. Symbols are the building blocks of animations 
because they are reusable objects such as 
graphics, buttons, and movie clips.

 9. Individual bones are rigged to create the 
skeleton, each bone is assigned a range of 
motion and a pivot point, and the bones are 
attached to the objects that compose the 
character.

 10. The movement of the parent object controls the 
movement of the child object and vice versa.

 11. By copying the code for the animation as a 
snippet and then pasting the snippet where 
needed.

 12. It contains objects that are not animated, such as 
the background, and requires only one frame.

 13. Blue.

 14. Light green.

 15. The playhead indicates the current frame in the 
animation; it moves across the timeline during 
animation playback and can be dragged to 
manually preview the animation.

 16. Two seconds.

 17. One-half second.

 18. Rich media that contains both video and audio.

 19. The animation may take longer to play or frames 
may be dropped out.

 20. Web browser in use, operating system of the 
device, and screen resolution of the device.
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Lesson 6
 1. The thickness of a line.

 2. Click the Lock corner radius controls to one 
control (chain link) button in the Rectangle 
Options area of the Properties panel so the 
button is on, and then enter the radius in the one 
active text box.

 3. The X value increases to the right of the stage, 
while the Y value increases to the bottom of the 
stage.

 4. The Subselection Tool.

 5. A black dot means the frame is a keyframe, 
blue means motion tweening, and green means 
shape tweening.

 6. Straight ahead (frame-by-frame) animation.

 7. The animation must be previewed in Flash, 
because only the stage is included in the 
compiled animation output to a SWF file.

 8. Click Play in the Control pull-down menu or 
drag the playhead.

 9. On the first frame of the motion, right-click on 
the object, select Create Motion Tween in the 
shortcut menu, move to the last frame of the 
motion, and drag the object to the new location. 
The motion path is automatically created, with 
one node on each tween.

 10. The motion of the object is changed.

 11. In the Motion Editor panel, change the setting in 
the Ease column to Simple (Slow), and adjust the 
value in the Eases area of the panel if needed.

 12. Drag and drop the layers into the folder.

 13. Shape tweening.

 14.  Drag the guideline and drop it on the ruler.

 15.  The text must be broken apart twice.

Lesson 7
 1. Identify the target audience and set the client 

goals.

 2. Sketches, a statement of deadlines and 
milestones, definition of the project scope, and 
detailed project specifications.

 3. Compatibility with Flash, format and size, and 
amount of rich media.

 4. SWF, AVI, GIF, and MOV.

 5. <object>, <embed>, or <video>

 6. A storyboard is a graphical representation of an 
intended visual process that is used to visualize 
graphic sequences and the user interface.

 7. Determine if it helps meet the business 
requirements of the project.

 8. It is a tool that helps store and organize assets 
used between Adobe products.

 9. It is important to meeting the deadline, helps 
improve usability of the output, and makes 
maintenance easier.

 10. It results in an aesthetically pleasing design and 
helps streamline the process.

 11. Reusing assets leads to consistency, which in 
turn reduces the total size of the project because 
there are fewer assets.

 12. With antialiasing using the Anti-Alias for 
Readability setting.

 13. It allows the screen reader to state a description 
of the image.

 14. Ensure enough white space is provided, 
overlapping content is avoided, a readable font is 
used, and the text is set in an appropriate size.

 15. Provide high contrast by using a light color for 
the text.

 16. [Alt] and [Tab]

 17. Permission must be obtained from the owner of 
the copyright to reuse the song.

 18. The material has no restrictions on use.
 19. The fair use doctrine.
 20. It is the letter C contained within a circle.
 21. An idea cannot be copyrighted; the material 

must be in tangible form.
 22. To stream video content.
 23. Movie_Apples_mc

 24. Observe, survey, or interview members of the 
target audience.

 25. Links, scripts, buttons, and rich content.
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Lesson 8
 1. Click the panel menu button in the Color panel, 

and click Add Swatch in the menu.

 2. Exported by clicking the panel button menu in 
the Swatches panel and clicking Save Colors… 
in the menu.

 3. The Motion Presets panel.

 4. Remove the head and tail and compress the 
audio.

 5. Create a new layer for the sound, add a 
keyframe for the frame on which the sound will 
begin, and drag the sound asset from the Library 
panel to the stage.

 6. Select the first frame of the waveform in the 
Timeline panel, and in the Properties panel click 
the Effect: drop-down arrow and select the 
effect.

 7. An event sound must be fully downloaded 
before it begins playing, while a streaming 
sound will begin to play as it is downloaded.

 8. Click File Info… in the File pull-down menu, and 
then add the metadata in the dialog box that is 
displayed.

 9. Click Test Movie and then In Flash (or In Flash 
Professional) from the Control pull-down menu.

 10. Exporting (File>Export>Export Movie…)

Lesson 9
Lesson
 15. import flash.display.Sprite;

Review Questions
 1.  flash.events

 2.  TimerEvent

 3.  myTimer

 4.  event:TimerEvent

 5.  var

 6.  A variable.

 7.  Uploads the variable data to a server.

 8. It closes the function and returns no value so 
Flash stops looking for a value.

 9. timerFunction

 10. addEventListener

Lesson 10
 1. In the User Interface folder on the Components 

panel.

 2. Parameters, which are input variable settings 
used in a computer programming argument.

 3. It identifies the object as a button that, when 
clicked, begins some action, such as starting a 
game or playback.

 4. The enable and visible check boxes in the 
Component Parameters area of the Properties 
panel must be checked.

 5. Apply the alpha color effect to the button fill 
color, and change the alpha value to less than 
100%, such as 50%.

 6. Over (changes from up to over).

 7. The method and parameter gotoAndStop(1) will 
return the movie to Frame 1 and stop playback. 
The user then must click the Play button, which 
must be properly programmed, to resume 
playback.

 8. A Flash package.

 9. Custom

 10. Place the cursor at the point in the code where 
the snippet is to be inserted, display the Code 
Snippets panel, select the snippet, and click the 
Add to Current Frame button. Finally, modify the 
code as needed.


